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PREFACE

The Agile documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology Network (OTN) Web 
site contains the latest versions of the Oracle|Agile PLM PDF files. You can view or download these manuals from 
the Web site, or you can ask your Agile administrator if there is an Oracle|Agile Documentation folder available on 
your network from which you can access the Oracle|Agile documentation (PDF) files.

To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or later. This program can be 
downloaded from the www.adobe.com.

The Oracle Technology Network (OTN) Web site can be accessed through Help > Manuals in both the Agile Web 
Client and the Agile Java Client. If applicable, earlier versions of Oracle|Agile PLM documentation can be found on 
the www.agile.com/support.

If you need additional assistance or information, please contact support@agile.com or phone (408) 284-3900 for 
assistance.

Before calling Agile Support about a problem with an Oracle|Agile PLM manual, please have ready the full part 
number, which is located on the title page.

Readme

Any last-minute information about Oracle|Agile PLM can be found in the Readme file on the Oracle Technology 
Network (OTN) Web site.

Agile Training Aids

Go to the Agile Training Web page for more information on Agile Training offerings.

http://www.oracle.com/technology/documentation/index.html
http://www.oracle.com/technology/documentation/index.html
http://www.adobe.com
http://www.oracle.com/technology/documentation/index.html
http://www.agile.com/support
http://www.oracle.com/technology/documentation/index.html
http://www.oracle.com/technology/documentation/index.html
http://training.agile.com
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CHAPTER 1
Introduction

This chapter introduces the Agile PLM Datamart. It has the following sections: 
❑ What is the Agile PLM Datamart?
❑ Who should Use the Agile PLM Datamart?
❑ Agile PLM Datamart Architecture

What is the Agile PLM Datamart?
The Agile PLM Datamart provides a platform and tools that let you conduct multidimensional analysis on Agile 
PLM data across the enterprise. Agile provides separate licenses for the following datamarts:

❑ Product Portfolio Management (PPM) Datamart

❑ Product Collaboration (PC) Datamart

❑ Product Quality Management (PQM) Datamart

Each Agile PLM Datamart product has the following components:

• Datamart – a multidimensional database with a set of common dimensions and a set of star schemas, each 
supporting a specific area of analysis – specifically, Product Collaboration, Product Portfolio Management, or 
Product Quality Management.

• Agile PLM Analytics Plugin – software for connecting to the Agile PLM server to retrieve metadata.

• ETL tasks – a collection of Extracting, Transforming, and Loading (ETL) tasks for DT/Studio; these are used 
to extract, transform, and load data into the Agile PLM Datamart.

Agile PLM Datamart schemas facilitate querying and reporting, which is valuable for analyzing performance trends 
and estimating future trends, and provides an intermediate store for historical Agile PLM data. Querying, reporting, 
and analysis require storage space and processing resources, and could have a significant impact on application 
performance if they ran against the transaction database. For this reason, Agile PLM and Agile PLM Datamart 
schemas have separate users, even though they can exist on the same database instance. The Agile PLM Datamart 
database schema is optimized for custom reporting, ad hoc queries, and analysis.

The Agile PLM Datamart contains all relevant data available in the Agile PPM, PC, and PQM solutions. The data 
model for the Agile PLM Datamart is different from the data model for the Agile PLM solutions in that it is better 
suited for querying and analysis. The Agile PLM Datamart is based on a modular decision-support architecture with 
a set of common dimensions. It comprises a set of star schemas—de-normalized Facts and a set of supporting 
Dimensions—each providing the basis for an area of functional analysis such as Financial Analysis, Time-to-Market 
Analysis, and so on.

Agile PLM Analytics is an open platform for analysis, based on industry-standard technologies. It gives you direct 
access to your data and lets you import data from other sources.
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Who should Use the Agile PLM Datamart?
The Agile PLM Datamart is useful to the following kinds of users:

❑ Users with operational business process responsibility, such as executives and project managers. These users can 
use the datamart for running standard reports and queries.

❑ Analysts or commodity managers who perform ad hoc queries and analyses in decision-making situations, such 
as time-to-market analysis, cost management, issues resolution, or portfolio score or trend analysis.

❑ Managers who can use the datamart to gather information about key performance indicators and historical 
trends.

❑ Information technology specialists who can integrate Agile PLM Datamart data with other datamarts or the 
company’s data warehouse.

Agile PLM Datamart Architecture
Agile Analytics includes several components, as represented by the following diagram.

Figure 1-1: Agile PLM Analytics Architecture

At the left of the diagram is the Agile PLM database, the transaction database that contains all Agile PLM data and 
is designed for executing business processes and user interface needs. External data sources are also represented at 
the left of the diagram. For example, with the help of Agile Solutions Delivery, you may implement an analytics 
solution that combines data from the Agile PLM database, external data sources, and additional flat files.

Using ETL tasks, the data is extracted from the data sources and loaded into relational schemas that comprise the 
Agile PLM Datamart:

❑ Staging schema — a schema that contains raw data, which can be used for staging purposes before moving to 
other datamarts.

❑ Dimensional schema — a star schema that enhances the performance of multidimensional queries. The 
dimensional schema summarizes transactions into multidimensional views for analysis and reporting, unlike the 
Agile PLM transactional database. User queries on the Agile PLM Datamart are extremely fast because the data 
consolidation has already been done.

❑ Administration schema — an administration schema that assists in the extract, transform, and load operations, 
but primarily serves as an administration database.
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Agile PLM Datamart
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Agile PLM Datamart Sample Configuration
The following figure shows a sample configuration for the Agile PLM Datamart.

Figure 1-2: Agile PLM Datamart Sample Configuration
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CHAPTER 2
Capacity Planning and Deployment

This chapter describes configuration and capacity planning and deployment strategies for the Agile PLM 
Datamart. It has the following sections: 
❑ Software Requirements
❑ Hardware Requirements
❑ Agile PLM Datamart Server Sizing

Important An Oracle database administrator should install the Agile PLM Datamart.

Software Requirements 
This table gives information about the operating systems and other software used in the Agile PLM Datamart. 

Hardware Requirements
Before you can install Agile PLM Datamart server components, you must have at least 1 GB of available disk space 
available where the OS is installed, in addition to the minimum disk space requirements specified in this guide.

Important Agile PLM Datamart computers and databases should be dedicated to Agile and should not have other 
software installed, unless otherwise specified. Do not attempt to include other database schemas or use the 
Agile host server as the primary domain controller (PDC) or dynamic host configuration protocol 
(DHCP) server.

Disk compression must be disabled on Agile computers.

When choosing a hardware configuration, consider the number of total users, the number of concurrent users, the 
size of your database, the number of ECOs processed per day, and overall activity level. If you have questions about 
your system, Agile Technical Support or your Agile Solutions Consultant can give guidance on whether you have 
small, medium, or large system requirements.

Components Operating System Other Software

PPM Datamart

PC Datamart

PQM Datamart

Windows 2003 Server Oracle 9i R2 Enterprise Edition (9.2.0.1)*

Oracle 10g R2 Enterprise Edition (10.2.0.1)

* Agile PLM Analytics requires Oracle10g. If you are installing 
both Agile PLM Datamart and Agile PLM Analytics, 
Oracle9i is not supported.

ETL components Windows 2003 Server Embarcadero Technologies DT/Studio 2.3.1

Agile PLM – Analytics Plugin Windows 2003 Server Oracle Application Server 10g (10.1.2.0.2) or 
BEA WebLogic Server 8.1 SP5

Agile PLM 9.2.1
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It is required that the computer on which you are installing Agile PLM Datamart components and the Oracle 
database have at least two physical drives or two partitions. This allows you to place the operating system on the C 
drive and use the D drive for Agile or Oracle components.

Tables 2-1 through 2-4 provide summary information for minimum hardware requirements based on database size. 

             

        

         

The Agile PLM Datamart database uses Oracle 9.2.0.1.0 or 10.2.0.1. Recommended database hardware depends on 
your Agile PLM Datamart system configuration. 

If you have only single processor computers and anticipate high network traffic, then the database and Agile 
Application Server should be installed on two different computers to avoid competition for resources on a single 
computer, which would outweigh any advantage gained from reduced network traffic.

Agile PLM Datamart Server Sizing
This section discusses the Agile PLM Datamart database design and architecture and provides sizing and capacity 
recommendations for practical deployment. The person who will installs and configures the Agile PLM Datamart 
should be knowledgeable about Oracle database administration.

The Agile PLM Datamart database is a Decision Support database that supports efficient OLAP. Consequently, its 
design and architecture is different from the Agile PLM database. OLAP is a resource intensive operation and the 
architecture goal is to optimize queries. The Agile PLM Datamart database has more memory sorting than the Agile 
PLM database and a larger temporary tablespace to accommodate long-running queries. To reduce full table scans, 
the database also has more indexes.

Table 2-1: Minimum hardware requirements—small database system (100 MB to 1 GB)

Hardware Windows OS

CPU Dual, 1.8 GHz Intel Xeon

RAM (GB) 1

Number and size of disks (partitions) Four 18-GB

Table 2-2: Minimum hardware requirements—medium database system (1 GB to 5 GB)

Hardware Windows OS

CPU Dual, 1.8 GHz Intel Xeon

RAM (GB) 2

Number and size of disks (partitions) Four 18-GB

Table 2-3: Minimum hardware requirements—large database system (2 GB to 16 GB)

Hardware Windows OS

CPU Four, 1.8 GHz Intel Xeon

RAM (GB) 4

Number and size of disks (partitions) Nine 18-GB

Table 2-4: Minimum hardware requirements—extra-large database system (5 GB to 38 GB)

Hardware Windows OS

CPU Eight, 1.8 GHz Intel Xeon

RAM (GB) 8

Number and size of disks (partitions) Twelve 18-GB
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For production databases, Agile recommends that you follow Oracle’s Optimal Flexible Architecture (OFA) 
guidelines. OFA is a popular specification for configuring high performance, low maintenance Oracle database 
systems.

Agile PLM Database Size

The target Agile PLM Datamart database size is directly related to the size of the source Agile PLM database. 
Therefore, it is strongly recommended that the Agile PLM Datamart database use the same database size model as 
the Agile PLM database. Typically the Agile PLM Datamart database size will be larger than that of the corresponding 
OLTP database since historical data is preserved in the datamart. The size of source data and the frequency of updates 
dictate how much space is needed over a given period of time.

Agile PLM Datamart Database Growth Pattern

For future growth plans, you should understand your database growth pattern and leave room for future growth. If 
the database data grows fast, then select a larger database size model or configure the database with more hardware 
resources, especially disk space.

Frequency of Running ETL

Depending on the frequency with which you extract data from the Agile PLM database and how long you intend to 
store the data on the Agile PLM Datamart database, you may need to plan for more disk space for the extracted data.

Reporting Usage

Reporting is a resource intensive operation. For heavy reporting usage of a separate OLAP tool (such as Symphony 
RPM) against the datamart, you should plan more hardware resource (additional CPUs and memory) to achieve 
best performance and concurrency. 

Hardware Resource Plan for Database Models

The following table lists recommended hardware resources for different database size models.

* Each disk has 18 GB disk space.

Disk Space and Tablespace Configurations

While the proper sizing of extents minimizes dynamic extensions in the same segments, disk I/O contention within 
the same logical tablespace or physical data file can also be harmful.

You can improve disk I/O performance for multiple disk configurations by spreading the I/O burden across multiple 
disk devices. The following sections describe the use of multiple disks for the Oracle database server. It is always 
advisable to use more disks. 

Table 2-1: Recommended hardware resources for different database sizes

Database Size CPU RAM Disks *

Demo 1 512 MB 1

Small 2 1 GB 4

Medium 2 2 GB 4

Large 4 4 GB 8

Extra-Large 12 8 GB 12
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One-Disk Configuration

A one-disk configuration is best for a demonstration, preproduction, and testing environment. This configuration 
results in disk I/O contention. In addition, as both usage and database size increase, performance significantly 
declines. The one-disk configuration is intended for demo database applications only, and the configuration can be 
implemented as shown in Table 2-5. 

There is no beneficial gain from OFA for the one-disk configuration from the perspective of disk I/O contention. 
There should be no significant impact on a current production database if you implement the default Oracle settings 
with a one-disk configuration.

Table 2-5: One-disk configuration for OFA implementation

Disk Oracle_Home Tablespaces Redo Logfiles

Disk 1 ORACLE_HOME SYSTEM
TOOL
UNDO
TEMP
USERS
INDX
AGILE_DATA1
AGILE_DATA2
AGILE_DATA3
AGILE_INDX1
AGILE_ADW_DATA1
AGILE_ADW_DATA2
AGILE_ADW_DATA3
AGILE_ADW_DATA4
AGILE_ADW_DATA5
AGILE_ADW_DATA6
AGILE_ADW_INDX1
AGILE_ADW_INDX2
AGILE_ADW_INDX3
AGILE_STG_DATA1
AGILE_STG_DATA2
AGILE_STG_DATA3
AGILE_AAD_DATA1

LOG1
LOG2
LOG3
LOG4
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Two-Disk Configuration

A two-disk configuration is best for a small database. To eliminate potential I/O contention, AGILE_DATA and 
AGILE_INDX data files are on separate disks. As usage and database size increases, performance declines.

Four-Disk Configuration

A four-disk configuration is best for an enterprise-level implementation of Agile. A four-disk configuration spreads 
the various data files, control files, and redo log files across multiple disk devices. 

❑ The three control files can be mirrored onto three different disks for best recovery protection.

❑ All potential I/O demand-intensive data files can be distributed onto their own separate disk. Redo log files are 
completely isolated from the rest of the data files, as the log files can cause significant I/O contention during 
transactions if they are sharing disks with other data files. The UNDO data file is separated from the schema data 
files and log files as well, so I/O contention can be minimized.

❑ The Agile schema tablespaces can be isolated from the rest of the SYSTEM, TEMP, TOOL, and UNDO data files.

Table 2-6: Two-disk configuration for OFA implementation

Disk Oracle_Home Tablespaces Redo Logfiles

Disk 1 ORACLE_HOME SYSTEM
TOOL
UNDO
AGILE_DATA1
AGILE_DATA2
AGILE_DATA3
AGILE_ADW_DATA1
AGILE_ADW_DATA2
AGILE_ADW_DATA3
AGILE_ADW_DATA4
AGILE_ADW_DATA5
AGILE_ADW_DATA6
AGILE_STG_DATA1
AGILE_STG_DATA2
AGILE_STG_DATA3
AGILE_AAD_DATA1

LOG1
LOG2

Disk 2 TEMP
USERS
INDX
AGILE_INDX1
AGILE_ADW_INDX1
AGILE_ADW_INDX2
AGILE_ADW_INDX3

LOG3
LOG4
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The four-disk configuration shown in Table 2-7 is recommended. For production database sites, the four-disk 
configuration represents the minimum requirements for an OFA implementation and provides the minimum 
hardware configuration for performance tuning. 

Eight-Disk Configuration

In addition to the advantages associated with a four-disk configuration, an eight-disk configuration supports an 
enterprise-level implementation of Agile by further spreading various data files and redo log files across multiple disk 
devices. Separating potentially large datafiles should help I/O contention as physical disk I/O is inevitable, due to the 
share size of data, as shown in Table 2-8. 

Table 2-7: Four-disk configuration for OFA implementation

Disks Oracle_Home Tablespaces Redo Logfiles Control files

Disk 1 ORACLE_HOME SYSTEM
TOOL
UNDO

 LOG1/2/3/4 Controlfile01

Disk 2 TEMP
USERS
INDX

Archive log file Controlfile02

Disk 3 AGILE_DATA1
AGILE_DATA2
AGILE_DATA3
AGILE_ADW_DATA1
AGILE_ADW_DATA2
AGILE_ADW_DATA3
AGILE_ADW_DATA4
AGILE_ADW_DATA5
AGILE_ADW_DATA6
AGILE_STG_DATA1
AGILE_STG_DATA2
AGILE_STG_DATA3
AGILE_AAD_DATA1

 Controlfile03

Disk 4 AGILE_INDX1
AGILE_ADW_INDX1
AGILE_ADW_INDX2
AGILE_ADW_INDX3

  

Table 2-8: Eight-disk configuration for OFA implementation

Disks Oracle_Home Tablespaces Redo Logfiles Control files

Disk 1 ORACLE_HOME SYSTEM
TOOL
UNDO

 LOG1/2/3/4 Controlfile01

Disk 2 TEMP
USERS
INDX

Archive log file Controlfile02

Disk 3 AGILE_DATA1
AGILE_DATA2
AGILE_DATA3

 Controlfile03

Disk 4 AGILE_ADW_DATA1
AGILE_ADW_DATA2
AGILE_ADW_DATA3

  

Disk 5 AGILE_ADW_DATA4
AGILE_ADW_DATA5
AGILE_ADW_DATA6
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Twelve-Disk Configuration

Further separating the AGILE_DATA and AGILE_INDX tablespaces, twelve-disk configurations can be 
implemented as shown in Table 2-9. 

Disk 6 AGILE_STG_DATA1
AGILE_STG_DATA2
AGILE_STG_DATA3

Disk 7 AGILE_AAD_DATA1
AGILE_INDX1

Disk 8 AGILE_ADW_INDX1
AGILE_ADW_INDX2
AGILE_ADW_INDX3

Table 2-9: Twelve-disk configuration for OFA implementation

Disks Oracle_Home Tablespaces Redo Logfiles Control files

Disk 1 ORACLE_HOME SYSTEM
TOOL

 LOG1/2/3/4 Controlfile01

Disk 2 USERS
INDX

Archive log file Controlfile02

Disk 3 UNDO  Controlfile03

Disk 4 TEMP   

Disk 5 AGILE_DATA1
AGILE_DATA2
AGILE_DATA3

Disk 6 AGILE_ADW_DATA1
AGILE_ADW_DATA2

Disk 7 AGILE_ADW_DATA3
AGILE_ADW_DATA4

Disk 8 AGILE_ADW_DATA5
AGILE_ADW_DATA6

Disk 9 AGILE_STG_DATA1
AGILE_STG_DATA2

Disk 10 AGILE_STG_DATA3
AGILE_AAD_DATA1

Disk 11 AGILE_INDX1
AGILE_ADW_INDX1

Disk 12 AGILE_ADW_INDX2
AGILE_ADW_INDX3

Table 2-8: Eight-disk configuration for OFA implementation (continued)

Disks Oracle_Home Tablespaces Redo Logfiles Control files
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CHAPTER 3
Installing the Agile PLM Datamart

This chapter describes how to install Agile PLM Datamart components. It has the following sections: 
❑ Installation Process
❑ Installing and Testing the Software on a Development Server
❑ Pre-Installation Checklist
❑ Starting the Agile PLM Datamart Installer
❑ Installing the Agile PLM Datamart Database
❑ Installing the Agile PLM – Analytics Plugin
❑ Installing Datamart ETL Tasks

Installation Process
Agile PLM Datamart is designed to run optimally on multiple computers. This guide is presented with separate 
chapters for certain Agile PLM Datamart components. To set up an Agile PLM Datamart system, you should install 
the components in the order shown in the following figure.

Figure 3-1: Agile PLM Datamart component installation order

Agile PLM Datamart 
Database

Install the Agile PLM Datamart on a separate database server.

Install the Agile PLM – Analytics Plugin on the Agile PLM 
Application Server.

Agile PLM – Analytics 
Plugin

Agile PLM Datamart 
ETL Components

Install Embarcadero Technologies DT/Studio 2.3.1 and Agile 
PLM Datamart ETL components on a separate computer 
from the Agile PLM Datamart database server.



Agile PLM 9.2.1

3-2 Agile PLM Datamart Installation and Administration Guide

Installing and Testing the Software on a Development Server
Install and test this release on a designated development server before installing it on your production environment. 
Your development environment should mirror your production environment as closely as possible to provide 
accurate testing results. It is important to validate the installation of this release and confirm your integrations are 
working correctly as part of your minimum due diligence. Any problems or questions noted during your 
development system testing should be resolved before installing this release on your production environment.

Pre-Installation Checklist
Before installing the Agile PLM Datamart software, you need to log in to your machine with local Administrator 
privileges and check the following:

Note You must complete this checklist before installing the Agile PLM Datamart.

Starting the Agile PLM Datamart Installer
The Agile PLM Datamart installer is a Java program. The installation of all components follows the same initial 
process up through the screen where you select the components to install.

Before running the installer, make sure 

❑ You have enough available disk space.

❑ You have disabled virus protection. 

If virus protection is enabled, components used in the installer can be falsely identified as being infected and lock 
up the installation. You can turn the virus protection on after the installation is complete.

To start the Agile PLM Datamart installer on Windows:

1 Log in to the computer using a login with local Administrator permissions. 

2 In the Disk1\Windows directory, double-click the setup.exe file.

After a few moments, the Welcome screen appears. 

3 For information about any screen in the installer, click Help.

Installer Online Help

Each installation screen has online help. At any time during installation, you can click Help for more information 
about the screen’s options.

Can you ping all servers, including the database server, on which you plan to install Agile PLM components? 
For example, try pinging the database server from the application server.

Have you verified the Domain Name System (DNS) hostname of each server on which you plan to install 
Agile PLM Datamart components? In DNS, the fully qualified domain name consists of the hostname, then 
a period, then the domain name.

Note When you are prompted by the Agile PLM Datamart installer to enter a hostname, enter the fully 
qualified domain name of the server.

Is your Agile PLM database server installed and running on a separate machine?

Is your Agile PLM application server installed and running on a separate machine?

Do you have local Administrator rights to the servers on which you plan to install Agile PLM Datamart 
components?
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Note If you leave the online help window open, it will be updated when you proceed through the installer 
screens. Otherwise, click Close at the bottom of the help window.

Installer Buttons

Agile PLM Datamart installation screens have the following buttons: 

❑ Cancel – Exits from the installation program. 

❑ Help – Displays online help. 

❑ Previous – Returns to the previous step. 

❑ Next – Proceeds to the next step. 

❑ Install – Starts installing. The Install button appears only on the Pre-Installation Summary screen, after you have 
specified installation options. 

❑ Done – Exits from the installation program. On Windows, after installing certain components you can choose 
whether to restart the computer when you click Done. The Done button appears only on the Install Complete 
screen, after you have finished installing. 

Installing the Agile PLM Datamart Database
Follow these steps to install the Agile PLM Datamart on the database server:

1 Install the Oracle database (Oracle 9i R2 or Oracle 10g).

2 Start the Agile PLM Datamart setup program, and install the Database Server component on the Oracle database 
server.

See “Starting the Agile PLM Datamart Installer” on page 3-2.

3 Check the installation log files to make sure the database was created successfully.

See “Checking Installation Logs on the Database Server” on page 3-3.

4 If this is the first time you have created a database on that computer, add and configure an Oracle Listener.

See “Adding and Configuring the Database Listener” on page 3-4.

Checking Installation Logs on the Database Server

After you install Agile PLM Datamart components on the database server, go to the <AnalyticsTemp> location to 
check for installation log files. Here are log files you will see:

❑ Service.log – log showing whether the database instance and database password file were created.

❑ check_connection.log – log showing whether the installer was able to establish a connection to the newly created 
database instance.

❑ DBInstall.log – installation log for creation of common tables used by the Agile PLM Datamart.

❑ PPM.log – Product Portfolio Management Datamart installation log.

❑ PC.log – Product Collaboration Datamart installation log.

❑ PQM.log – Product Quality Management Datamart installation log.

❑ AdvancedPPM.log – PPM Analytics installation log.
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Adding and Configuring the Database Listener

The Oracle Listener supports client connections to the database. If this is the first time Oracle has been installed on 
the current computer, you need to add and configure a new Listener.

If an Oracle database instance was previously installed on the computer before you installed the Agile PLM Datamart 
database, you can skip adding a new Listener. However, you still need to configure the Listener address for the Agile 
PLM Datamart, as described below.

To add a new Listener address: 

1 If the Agile PLM Datamart is the first database instance created on this computer, the Net Configuration 
Assistant Welcome screen appears.

If there is already a Listener, click Finish. Otherwise, continue.

2 Select Listener Configuration. Click Next. 

3 Select Add to add a listener to the database. Click Next.

4 Accept the default listener name, LISTENER, in the Listener Name dialog box. Click Next.

5 Accept TCP as the Selected Protocol. Click Next.

6 Accept the standard port of 1521. Click Next.

7 Select No when asked to configure another listener. Click Next.

8 The Listener configuration is complete. Click Next.

9 Click Finish to close the Oracle Net Configuration Assistant window.

To configure a new Listener address for the Agile PLM Datamart:

1 Start the Oracle Net Manager by choosing Start > Programs > Oracle - OraHome92 > Configuration and Migration Tools > Net 
Manager.

2 In the Oracle Net Manager window, double-click the Local folder and select the Listeners folder. 

3 Click the name of the newly created listener, LISTENER.

4 Select Database Services in the Listening Locations drop-down list.

a Click Add Database.

b In the dialog box that appears, make the following changes:

• Global Database Name: aadm

• Oracle Home Directory: <oracle_home>

• SID: aadm

Note If you used a different global database name during the database installation, change the information 
as appropriate.

5 Choose File > Save Network Configuration to save your changes.

Deleting an Existing Agile PLM Datamart Database Instance

When you purchase the Agile PLM Datamart, you can obtain licenses for any combination of the PPM Datamart, 
PC Datamart, and PQM Datamart. If you later obtain additional Agile datamart licenses, you can choose whether to 
install over the existing database instance or to delete the existing database instance and create a new instance.

If you install over an existing Agile PLM Datamart database instance, there will be several errors in the installation 
logs that say that the database, tablespaces, and database users already exist. You can ignore these errors.
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If you’ve already installed the Agile PLM Datamart and have obtained additional datamart licenses from Agile, you 
can delete the existing database instance manually by using one of the following approaches. Afterward, you can then 
install a fresh database instance.

To delete a database instance using the Command Line:

1 Open a Command Prompt window.

2 Enter the following commands to set environment variables:

D:\> Set ORACLE_HOME=<ORACLE_HOME>
D:\> Set PATH=%PATH%;<ORACLE_HOME>\bin;
D:\> Set ORACLE_SID=<SID_NAME>
D:\> Set NLS_LANG=American_America.UTF8

3 Start SQL*Plus without connecting to the database:

D:\> sqlplus /nolog

4 Run the following SQL commands:

SQL> connect sys/<SYS_PWD> as sysdba
SQL> shutdown immediate

5 Delete the Agile PLM Datamart SID (the default SID name is “aadm”) and its password file:

D:\> <ORACLE_HOME>\bin\oradim -delete -sid <SID_NAME>
D:\> del <ORACLE_HOME>\database\pwd<SID_NAME>.ora

To delete a database instance using Oracle’s Database Configuration Assistant:

1 Choose Start > All Programs > <Oracle_Home> > Configuration and Migration Tools > Database Configuration Assistant.

2 Click Next.

3 Choose Delete a Database. Click Next.

4 Select the SID associated with the Agile PLM Datamart. The default SID is “aadm”. Enter a database username 
and password (such as system/manager). Click Finish.

The Summary dialog box appears.

5 Click OK to continue.

A confirmation dialog box appears.

6 Click Yes to continue.

After the database is deleted, you are prompted whether to perform another operation.

7 Click No to exit.

Removing Database Files

After you delete a database instance, the database’s datafiles, redo log files, and all other associated files (control files, 
initialization parameter files, and archived log files) must be removed manually. To view the names of the database's 
datafiles, redo log files, and control files, query the V$DATAFILE, V$LOGFILE, and V$CONTROLFILE data 
dictionary views, respectively.

If the database is in archive log mode, locate the archive log destinations by inspecting the initialization parameters 
LOG_ARCHIVE_DEST_n, or LOG_ARCHIVE_DEST and LOG_ARCHIVE_DUPLEX_DEST.

Starting the Database Manually

If you restart the database server and notice that the database is idle even though the Oracle Service is running, you 
can start the database manually using the STARTUP command.
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To start the database manually:

1 Open a Command Prompt window.

2 Start SQL*Plus without connecting to the database:

D:\> sqlplus /nolog

3 Connect to Oracle as SYSDBA:

SQL> CONNECT system/<SYSTEM_PASSWORD> as sysdba

4 Start the database:

SQL> STARTUP

5 Disconnect from Oracle:

SQL> DISCONNECT

6 Exit from SQL*Plus:

SQL> EXIT

Installing the Agile PLM – Analytics Plugin
Follow these steps to install the Agile PLM – Analytics Plugin on the Agile PLM application server.

To install the Agile PLM – Analytics Plugin on Oracle Application Server:

1 Stop the Web proxy server used for Agile PLM.

2 Make sure the Agile PLM application server is running.

3 Start the Agile PLM Datamart setup program, and install the Agile PLM – Analytics Plugin component on the Agile 
PLM application server.

See “Starting the Agile PLM Datamart Installer” on page 3-2.

Note If you have an application server cluster, install the plugin on the repository host server only. During 
installation, the Agile application is repackaged and redeployed to all servers in the cluster.

4 Restart the Web proxy server used for Agile PLM.

To install the Agile PLM – Analytics Plugin on WebLogic Server:

1 Stop the Web proxy server used for Agile PLM.

2 Stop the Agile PLM application server. Choose Start > All Programs > Agile > Agile 9.2.1 > Stop Agile Server.

3 Start the Agile PLM Datamart setup program, and install the Agile PLM – Analytics Plugin component on the 
Agile PLM application server.

See “Starting the Agile PLM Datamart Installer” on page 3-2.

Note If you have an application server cluster, install the plugin on the WebLogic Administration Server only. 
The Agile application is redeployed to all Managed Servers in the cluster.

4 Restart the Agile PLM application server. Choose Start > All Programs > Agile > Agile 9.2.1 > Start Agile Server.

5 Restart the Web proxy server used for Agile PLM.

Updating the Agile License Key

When you purchase the Agile PLM Datamart, you should receive a new license key from Agile Software. Make sure 
you update the license key for your Agile PLM system. Your license key controls which Agile PLM Datamart ETL 
tasks can be run against the server.
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To update your Agile license key using Agile Java Client:

1 Copy your new Agile license key to the Clipboard.

2 Start the Agile Java Client, and log in as an administrator.

3 Click the Admin tab.

4 Under Server Settings, double-click the Licenses node. The Licenses window appears.

5 In the License Key field, paste your new Agile license key.

6 Click Save.

7 Restart the Agile PLM application server.

To update your Agile license key using Oracle SQL*Plus:

1 On the Agile PLM database server, open a Command Prompt window.

2 Start SQL*Plus and log in as the Agile user. The default Agile user and password is agile/tartan, and the default 
SID is “agile9”.

D:\> sqlplus agile/tartan@agile9

3 Run the following command:

SQL> update propertytable set value='<newLicenseKey>' where id=44051;

4 Restart the Agile PLM application server.

Note If you update the Agile license key after installing Agile PLM Datamart ETL tasks, you must also restart the 
DTEngineManagerService and the DT/Engine on the ETL computer.

Installing Datamart ETL Tasks
Follow these steps to install Agile PLM Datamart ETL tasks:

1 Make sure Agile PLM application server is installed and running and is using the latest license key you have.

See “Updating the Agile License Key” on page 3-6.

2 Make sure the Agile PLM Datamart database is installed and running.

3 Install Embarcadero DT/Studio 2.3.1 components. This includes DT/Engine and DT/Console.

See Appendix D, “Installing Embarcadero DT/Studio.”

4 Make sure you have configured DT/Engine to connect to a database repository. For example, you can create a 
separate database user for DT/Engine on the Agile PLM Datamart computer or on another Oracle database.

5 Start the Agile PLM Datamart setup program, and install the Datamart ETL Tasks component.

See “Starting the Agile PLM Datamart Installer” on page 3-2.

6 Check the installation log file to make sure the ETL components were installed successfully.

See “Checking the Installation Log on the ETL Server” on page 3-7.

Checking the Installation Log on the ETL Server

After you install Agile PLM Datamart ETL tasks on the ETL computer, check the 
<agile_home>\Install\logs\Agile_PLM_Datamart_InstallLog.log file for any errors. It lists all the ETL tasks that are 
installed. If you encountered any errors, you may need to reinstall. If you are unable to resolve a problem by 
reinstalling, contact Agile Support.
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Agile PLM Datamart ETL Folders

After Agile PLM Datamart ETL components are installed, the <AgileAnalyticsHome> folder has the following 
subfolders:

Uninstalling Agile PLM Datamart ETL Tasks

If you want to undeploy Agile PLM Datamart ETL tasks from the DT/Engine repository, you can uninstall them 
using Agile’s uninstall program. To remove DT/Studio components, use uninstall programs provided with 
DT/Console and DT/Engine.

To remove Agile PLM Datamart ETL tasks:

1 On the ETL computer, make sure the DTEngineManagerService is started.

2 Choose Start > Programs > Agile > Agile PLM Datamart > Uninstall Agile PLM Datamart.

The uninstaller program starts.

3 Click Uninstall.

4 Click Done when finished.

Table 3-1: Agile PLM Datamart ETL folders

Folder Contains

bin Extract, Transform, and Load (ETL) scripts used to extract and load Agile PLM data.

classes Java classes used to do the extraction and loading of data.

config Configuration files.

ETL Extraction, transformation, and load scripts.

lib Java libraries used by the ETL scripts.

logs Log files generated by the Agile PLM Datamart ETL scripts.

schema Contains the schema documentation for the Agile PLM Datamart.
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CHAPTER 4
Administering the Agile PLM Datamart

This chapter provides information about administering the Agile PLM Datamart. It contains the following 
topics:
❑ Overview of Agile PLM Datamart Administration
❑ Configuring Custom Agile PLM Fields
❑ Using DT/Studio to Run Agile PLM Datamart ETL Scripts

Overview of Agile PLM Datamart Administration
Agile PLM Datamart administration is fairly straightforward, mainly because the Agile PLM Datamart database is a 
separate database that must be maintained and administered separately from the Agile PLM server. For effective use 
of Agile PLM Datamart, data must be extracted from the Agile PLM server, transformed, and loaded to the Agile 
PLM Datamart database on a regular basis. The Agile PLM Datamart includes DT/Studio, an ETL engine from 
Embarcadero Technologies, to manage the ETL process.

Configuring Custom Agile PLM Fields
Users with Administrator privileges can configure custom fields on Page Two and Page Three for any Agile PLM 
subclass. Data for enabled Cover Page, Page Two, and Page Three attributes is loaded into flattened summary tables 
in the Agile PLM Datamart. These summary tables use the naming convention ADW_XXX_XXX_SUM. A separate 
summary table is created for each subclass. If you subsequently enable or disable attributes on the Cover Page, Page 
Two, or Page Three, when you run the ETL tasks again they automatically create a new summary table to reflect your 
changes.

Using DT/Studio to Run Agile PLM Datamart ETL Scripts
After you install Agile PLM Datamart ETL components, the <AA_HOME>\ETL folder contains XML scripts used 
to extract, transform, and load data. In DT/Studio, these scripts are also referred to as task definition files. They 
perform the following functions:

❑ Extract data from the Agile PLM database.

❑ Transform the records so they adhere to the structure in the Agile PLM Datamart database schema.

❑ Load the data into the Agile PLM Datamart database.

How Your Agile License Key Affects ETL Tasks

Your ability to run ETL tasks for individual Agile PLM Datamart modules is based on your Agile license key. For 
example, if you have a license key only for the PQM Datamart, you cannot run PPM Datamart and PC Datamart 
ETL tasks.
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Starting an Agile PLM Datamart Task in DT/Studio

You can run Agile PLM Datamart ETL scripts using DT/Console, a Java application. The XML scripts are DT/Studio 
task definition files. 

To run an Agile PLM Datamart ETL script:

1 Make sure DT/Engine Manager is started.

2 Start DT/Console by clicking Start > Programs > Embarcadero DT/Studio 2.3.1 > Embarcadero DT/Console 2.3.1 > 
DT/Console 2.3.1.

3 If this is the first time you are running DT/Console or if you do not automatically connect to the DT/Engine, you 
are prompted to log in. Enter the username and password, and click OK.

Note The default DT/Engine username/password is dtadmin/dtadmin123. For information about changing the 
DT/Engine password, see Appendix F, “Changing Passwords.”

4 After logging in, open the Tasks node. By default, the following tasks appear:

• PLM_AA_POST_TASK – Increments the batch number by one for Agile PLM Datamart data loads.

• PLM_ADW_COM_ALL – Loads common Agile PLM data from the Staging schema into the Dimensional 
schema of the Agile PLM Datamart.

• PLM_ADW_ADVPA_ALL – Loads data related to PPM Analytics from the Staging schema into the 
Dimensional schema of the Agile PLM Datamart.

• PLM_ADW_PA_ALL – Loads data related to Product Portfolio Management from the Staging schema into 
the Dimensional schema of the Agile PLM Datamart.

• PLM_ADW_PCA_ALL – Loads data related to Product Collaboration from the Staging schema into the 
Dimensional schema of the Agile PLM Datamart.

• PLM_ADW_PQA_ALL – Loads common Agile PLM data from the Staging schema into the Dimensional 
schema of the Agile PLM Datamart.

• PLM_AST_COM_ALL – Extracts common Agile PLM data from the Agile PLM database and loads it into the 
Staging schema of the Agile PLM Datamart.

• PLM_AST_PA_ALL – Extracts Product Portfolio Management data from the Agile PLM database and loads 
it into the Staging schema of the Agile PLM Datamart.

• PLM_AST_PCA_ALL – Extracts Product Collaboration data from the Agile PLM database and loads it into 
the Staging schema of the Agile PLM Datamart.

• PLM_AST_PQA_ALL – Extracts Product Quality Management data from the Agile PLM database and loads 
it into the Staging schema of the Agile PLM Datamart.

Note A task chain called Agile Analytics runs all the above tasks.

If no tasks appear in the Tasks node, it could be because the DT/Repository has not been set. For 
information on how to set the repository, see the separate DT/Studio documentation.

5 Select a task, and click the  Start button.

Note Before starting to extract Agile PLM data, make sure the Agile PLM application server and the Agile PLM 
database are both up and running.

When you run a DT/Studio task such as PLM_AST_PA_ALL, it actually calls several subtasks to move data from the 
Agile PLM database to the Agile PLM Datamart database. The subtasks extract and load all Agile PLM data, not just 
the information that changed since the last time you ran the task.

The time it takes to perform a data load depends on the size of data contained in your Agile PLM system. It can take 
several hours.
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Weekly or nightly batch runs are recommended, but multiple batches may be processed as required. You can use the 
DT/Console scheduler to schedule a task to run automatically.

The results from each task that you run are stored in task log files, which are accessible from the Log tab in 
DT/Console.

Recommended Order of Tasks

The Agile Analytics task chain runs Agile PLM Datamart tasks in the following order:

1 PLM_AST_COM_ALL

2 PLM_AST_PA_ALL

3 PLM_AST_PCA_ALL

4 PLM_AST_PQA_ALL

5 PLM_ADW_COM_ALL

6 PLM_ADW_PA_ALL

7 PLM_ADW_PCA_ALL

8 PLM_ADW_PQA_ALL

9 PLM_ADW_ADVPA_ALL

10 PLM_AA_POST_TASK

Of course, it’s really only essential to run the tasks that load data into the staging schema first 
(PLM_AST_COM_ALL, PLM_AST_PA_ALL, PLM_AST_PCA_ALL, and PLM_AST_PQA_ALL). What you do 
with the staged data is completely up to you. Once the data is in the staging area, you can perform other 
transformations before loading the data into the dimensional schema.

Stopping a DT/Studio Task

DT/Studio runs a task until it and its subtasks are finished. You can stop a task from running at any time. If you want 
to stop a task from running mid-task, you must first close DT/Console and then stop and restart DT/Engine.

To stop an Agile task running in DT/Studio:

Because Agile tasks run in a separate Java program, rather than stopping DT/Console as described above, simply 
close DT/Console and then stop DT/Engine. When you are ready for your task to run again start DT/Engine and 
then open DT/Console. Whether or not your task resumes running where it left off or starts again from the 
beginning depends on the properties you set for the task. For more information, see the next section.
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Modifying a Task’s Properties

You can restart a task that you’ve stopped. How the task behaves when you restart it depends on settings contained 
in the task’s custom.properties file. The custom.properties files are located in the <AA_HOME>\ETL subfolders 
(Common, PA, PCA, PQA, Staging). For example, if the isFullLoad property is set to 1 (True), the task runs from 
beginning to end. If isFullLoad is set to 0 (False), then the task runs from the last subtask that completed 
successfully.

The following table lists the properties you can set for each task.

Checking the Task Log

After running a DT/Studio task, you can check Log tab to see if the data loaded successfully. If any of the task chains 
fail, you need to identify which of the subtasks failed and then view the task’s file-based log.

To view the file-based log for a DT/Studio task:

1 Select the Tasks node in the navigation pane in the left.

2 In the right pane, click the End Date/Time column to sort by the end date.

3 Scroll down until you see a task that aborted. The status column will read “Aborted.”

4 Right-click the aborted task, and choose View File Based Log from the shortcut menu.

5 Select a transformer that’s red, which means it failed.

6 Click Refresh to view the log.

Note The physical log files for DT/Studio tasks are stored in the <DT_HOME>\logs\task folder.

Scheduling DT/Studio Tasks

DT/Console provides a simple scheduling tool that lets you run tasks on a recurring basis, such as daily or weekly. 

You should schedule extractions and loading of data during off-hours, such as at night when very few users are 
accessing the Agile PLM and Agile Datamart databases.

Note Before using the DT/Console scheduler, confirm that the system date and time on your computer are 
accurate.

To schedule DT/Studio tasks:

1 In DT/Console, select the task and click the  Add Schedule button. The Schedule Properties dialog box appears.

2 Specify the schedule name, start date, start time, and recurrence settings (such as whether the task runs on a daily 
basis). Click OK.

3 When prompted that the schedule has been added, click OK.

Table 4-1: custom.properties

Property Description

debug Sets whether logging is enabled. Default is 1 (true).

isFullLoad Sets whether to perform a full load of data, or to resume from the last subtask that was completed. 
Default is 1 (true).

initialize Sets whether to deploy the task to the repository. Default is 1 (true).

dbtype Sets the database type.

CUSTOM_TASK The specified custom task is used to move some statistical data to a table in the administrative 
schema of the Agile PLM Datamart. Do not modify this setting.

PRE_TASK Sets global variables for DT/Engine before running the task.

POST_TASK Resets global variables for DT/Engine after running the task.
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APPENDIX A
Agile PLM Datamart Installer Panels

This appendix describes panels in the Agile PLM Datamart installer. It includes the following information:
❑ Common Installer Panels
❑ Database Server Panels
❑ Agile PLM - Analytics Plugin Installer Panels
❑ Datamart ETL Tasks Installer Panels

Common Installer Panels
The following Agile PLM installer panels are common to all components:

Table A-1: Common installer panels

Panel Step(s) to Perform

Welcome Click Next.

License Agreement Read the Agile PLM Datamart license agreement, and then select I accept the terms 
of the license agreement.

Customer Information Enter your user name and company name.

Note: Your username must be at least five characters.

Choose Component(s) Select Agile PLM Datamart components to install. 

• Database Server – creates an instance of the Agile PLM Datamart on your 
database server. 

• Agile PLM - Analytics Plugin – installs additional libraries for integration with 
the Agile PLM server.

• Datamart ETL Tasks – installs software for extracting, transforming, and 
loading Agile PLM data into the datamart. 

Make sure you select only components that should be installed on this computer. 
Generally, you should not install all components on the same computer.

When you select each component, a description of it appears in the Description 
box.

Application Server Type Select the type of application server you are using. Agile PLM supports Oracle 
Application Server 10g (10.1.2.0.2) and BEA WebLogic Server 8.1 SP5.

Pre-Installation Summary Review the information you provided in previous panels to make sure it's correct 
before you install.

If the information is correct, click Install. If you need to make any changes, click 
Previous to go to a previous panel.
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Database Server Panels
The following installer panels appear when you install the Database Server:

Install Complete You have finished installation.

Click Done to close the installer.

Depending on the components you installed, you can choose to restart your 
computer automatically when you click Done, or you can restart it manually later.

Table A-2: Database Server installer panels

Panel Step(s) to Perform

Destination Location Enter the destination drive and folder for your Agile PLM Datamart database 
instance scripts.

Click Choose to browse to your preferred location.

Click Restore Default to restore the default path for the field (c:\AnalyticsTmp).

Choose Database Version Select the version of your Oracle database server. Agile supports the following 
Oracle versions: 

• Oracle 10g Database Server 
• Oracle 9i R2 Database Server 

For complete instructions on how to install Oracle, see the Oracle documentation.

Oracle Database Base & Home Directories Enter the destination drive and folder for: 

• Oracle Base Directory 
• Oracle Home Directory 

Click Choose to browse to the location.

Click Restore Default to restore the default path for the field.

Instance Name Enter the name of the instance you are creating. The default instance name is 
AADM (for Agile Analytics Datamart).

Database Size Estimate Select an appropriate general size of your database: 

• Demo
• Small
• Medium
• Large
• Extra Large

Each database size has minimum memory and hardware requirements. This 
choice should be made after considering existing disk space and anticipated size 
of your datamart data.

Table A-1: Common installer panels (continued)

Panel Step(s) to Perform
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Database Security and Datamart User 
Information

Enter passwords to be used:

Internal / Sys Password 
The default SYS password is “Oracle”. The SYS user owns all base tables and the 
user-accessible view of the data dictionary. 

SYSTEM Password 
Enter the SYSTEM password. The SYSTEM user is used to create tables and 
views for administrative information and internal tables and views used by 
various Oracle tools. 

Datamart Admin User Password 
Enter the password for the Datamart Administration user. The default password 
is “aad”. 

Datamart Staging Schema Password 
Enter the password for the Datamart Staging Schema. The default password is 
“ast”. 

Datamart Dimensional Schema Password 
Enter the password for the Datamart Dimensional Schema. The default 
password is “adw”. 

Tablespaces (Data Files) 1 Select the location of Oracle tablespaces (data files). You should accept the default 
settings, unless you have additional hard drives with sufficient space available that 
allow you to distribute the files across multiple hard drives.

The data files to assign in this panel are: 

• SYSTEM 
• INDEX 
• TEMP 

Click Choose to browse to the location.

Click Restore Default to restore the default path for the field.

Tablespaces (Data Files) 2 Select the location of Oracle tablespaces (data files). You should accept the default 
settings, unless you have additional hard drives with sufficient space available that 
allow you to distribute the files across multiple hard drives.

The data files to assign in this panel are: 

• Dimensional Data 
• Staging Data 

Click Choose to browse to the location.

Click Restore Default to restore the default path for the field.

Control Files Select the location of Oracle control files. You should accept the default settings, 
unless you have additional hard drives with sufficient space available that allow 
you to distribute the files across multiple hard drives.

The data files to assign in this panel are:

• Control File 1 
• Control File 2 
• Control File 3 

Control files are used to track the location of database files on the system. A 
control file contains the database name, the name of the database files, and the 
names of the redo log files. The control file also stores archive history.

Click Choose to browse to the location.

Click Restore Default to restore the default path for the field.

Table A-2: Database Server installer panels (continued)

Panel Step(s) to Perform
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Agile PLM - Analytics Plugin Installer Panels
The following Agile PLM Datamart installer panels appear when you install the Agile PLM - Analytics Plugin:

Datamart ETL Tasks Installer Panels
The following Agile PLM Datamart installer panels appear when you install Datamart ETL Tasks:

Oracle Log Files Enter folder path to store redo log files. You should accept the default setting 
unless you have additional hard drives with sufficient space available that allow 
you to distribute the files across multiple hard drives.

Redo log files record changes made in an Oracle database. These files should be 
stored separately from the datafiles. If a database or hard disk fails, you can use the 
redo log files to update the database data back to the instant the failure occurred.

As Oracle records changes, it cycles through the redo log files. If an Archive Log is 
enabled, Oracle will archive a redo log before overwriting it. The archived redo 
logs plus the online redo logs provide a complete history of changes made to the 
database.

Click Choose to browse to the location.

Click Restore Default to restore the default path for the field.

Table A-3: Agile PLM - Analytics Plugin installer panels

Panel Step(s) to Perform

Oracle Application Server Home Enter the home directory where Oracle Application Server is installed.

Click Choose to browse to the location.

Click Restore Default to restore the default path for the field.

WebLogic Application Server Home Type the location of the BEA WebLogic Server Home Directory, or click Choose to 
browse to it.

The WebLogic Application Server Home directory is the location where BEA 
WebLogic Server is installed (for example, c:\bea\weblogic81).

Agile PLM Server Home Enter the directory where Agile PLM is installed. This directory is also referred to 
as the Agile Home. The default Agile Home is d:\Agile\Agile921.

Table A-4: Datamart ETL Tasks installer panels

Panel Step(s) to Perform

Installation Location Enter the directory where you want to install Agile Analytics components. This 
directory is also referred to as the Agile Home.

Agile PLM DT Engine Details Enter the administrator username and password for DT/Engine.

The default administrator username is “dtadmin” and the default administrator 
password is “dtadmin123”.

Table A-2: Database Server installer panels (continued)

Panel Step(s) to Perform
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Agile PLM Database Details Enter your source Agile PLM database information. The database must be 
running and you must have a net service configured to connect to it. If you do not 
know these values, see the database administrator responsible for your Agile PLM 
database server.

Agile Database Host Name 
Enter the fully qualified domain name of the computer where the Agile PLM 
database server is installed. 

Agile Database Port 
Enter the database port. For Oracle, the default database port is 1521. 

Agile Database SID 
Enter the Oracle System Identifier that refers to the instance of the Oracle 
database running on the server. The default SID is “agile9”. 

Agile Database User 
Enter the database user. The default user is “agile”. 

Agile Database User Password 
Enter the password for the Agile PLM database user. The default password is 
“tartan”. 

Note: If your Agile PLM database is configured to use different values than the 
defaults listed above, specify that information instead.

PLM Datamart Database Details Enter your destination Agile PLM Datamart database information. The database 
must be running and you must have a net service configured to connect to it. If 
you do not know these values, see the database administrator responsible for your 
Agile PLM Datamart database server.

PLM Datamart Database Host Name 
Enter the fully qualified domain name of the computer where the Agile PLM 
Datamart database server is installed. 

PLM Datamart Database Port 
Enter the database port. For Oracle, the default database port is 1521. 

PLM Datamart Database SID 
Enter the Oracle System Identifier that refers to the instance of the Oracle 
database running on the Agile PLM Datamart server. The default SID is “aadm” 
(for Agile Analytics Datamart). 

PLM Datamart Admin User Password 
Enter the Admin schema (AAD) database user password for the Agile PLM 
Datamart. The default password is “aad”. 

PLM Datamart Staging Schema Password 
Enter the Staging schema (AST) database user password for the Agile PLM 
Datamart. The default password is “ast”. 

PLM Datamart Dimensional Schema Password 
Enter the Dimensional schema (ADW) database user password for the Agile 
PLM Datamart. The default password is “adw”. 

Note: If your Agile PLM Datamart database is configured to use different values 
than the defaults listed above, specify that information instead.

Agile Analytics Login URL Specify the fully qualified URL to access the Agile PLM server. This is the same 
URL that Agile SDK programs use to connect to the Agile PLM server.

Format:

<protocol>://<fully_qualified_hostname>/<virtualPath>

Example:

http://plm.agile.agilesoft.com/Agile

Start of the Fiscal Year Specify the day and month that begins your company's fiscal year. This setting 
allows you to perform analysis of Agile PLM data based on your company's fiscal 
year or the calendar year.

Table A-4: Datamart ETL Tasks installer panels (continued)

Panel Step(s) to Perform
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APPENDIX B
Installing Oracle 9i

This appendix provides instructions for installing Oracle 9i (9.2.0.1.0) on Windows.
❑ Before Installing Oracle 9i on Windows
❑ Installing Oracle 9i Release 2 on Windows

Important Agile PLM Analytics requires Oracle10g. If you are installing both Agile PLM Datamart and Agile PLM Analytics, 
Oracle9i is not supported.

Before Installing Oracle 9i on Windows
Before installing Oracle, you must:

❑ Check to see that the Microsoft NTFS file system is used instead of FAT or FAT32, and convert the file system if 
necessary. See “Checking the Windows File System” on page B-2 for directions.

❑ Determine the name of the Windows computer where Oracle is to be installed. The target installation folder for 
the Oracle database is recommended to be d:\oracle\ora92.     

Note It is required that the computer on which you are installing the Oracle database have at least two physical 
drives or two partitions. This allows you to place the operating system on the C drive and use the D drive 
for Oracle components. The examples in this chapter use a C and D drive.

❑ Be sure that you have Administrator privileges within Windows on the computers where you are installing Oracle 
and Agile PLM Datamart.

❑ Disable disk compression, if you are using it.

❑ Disable virus protection, if you are using it. Components used in the installer can be falsely identified as being 
infected and lock up the installation. You can turn the virus protection on after the installation is complete. 

The following sections provide more information about these procedures.

Network Check

Before proceeding, it is important to confirm two settings to prevent difficulties from occurring.       

Confirming Computer Name and Hostname Identities

The computer where Oracle is installed must use the same value as both its computer name and its DNS hostname. 
The following procedures can be used to identify the current values.
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To determine the computer name for Windows:   

1 Right-click the My Computer icon on the desktop, and choose Properties in the shortcut menu. 

2 In the System Properties dialog box, click the Computer Name tab. 

3 Note the name listed in the Full Computer Name field.

Confirming the Server Date

It is important to adjust the date and time of the computer. The date and time need to be correct when you work 
with your production data.

To confirm the date and time, click the Date/Time icon in the Windows Control Panel. Be sure to verify the Time Zone 
setting, too.

Checking the Windows File System

Agile recommends that servers use NTFS (NT File System) rather than FAT or FAT32 (File Allocation Table), as 
NTFS is more robust. 

To determine the file system type:

1 Check the file system used on the computer. Choose Start > Administrative Tools > Computer Management. Under 
Computer Management in the left pane, expand Storage and select Disk Management.

The Disk Administration windows opens.

There must be at least two partitions or hard drives. If your computer uses NTFS, proceed with the Oracle 
installation. If your computer uses a FAT or FAT32 file system, Agile recommends converting it to NTFS before 
proceeding.

Important Converting the file system deletes all current files on the drive. Backup all necessary files before 
converting the file system to NTFS. 

2 Right-click on the drive you want to reformat and choose Format in the shortcut menu.

3 In the File System field, change the file system type to NTFS.

4 Click Start.

The process takes several minutes. On completion, restart the system. You can proceed with the Oracle installation.

Installing Oracle 9i Release 2 on Windows
These instructions describe how to install and configure Oracle 9i to run with Agile PLM Datamart.

Note Throughout the instructions, default values are shown (such as the installation path or the service name). 
If you change any of these values during the installation, update the information specific to your 
installation where appropriate. 

Important Make sure the Distributed Transaction Coordinator service is stopped.

To install Oracle 9i:         

1 Insert the Oracle database installation CD. You may have to navigate to the CD drive. Click Next. 

2 The Oracle Universal Installer welcome screen appears. Click Next.

The File Locations window appears.

3 Make sure the Oracle home folder is on the D drive at d:\oracle\ora92. Click Next.

Note  If you are installing Oracle on a different drive, specify that drive instead. 

The Available Products window appears.    
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4  Select Oracle9i Database 9.2.0.1.0. Click Next.

The Installation Types window appears.     

5 Select Enterprise Edition. Click Next.

The Database Configuration window appears. 

6 Select Software Only. Click Next.

The Oracle Services for Microsoft Transaction Server window appears.

7 Accept the default 2030 port number. Click Next.

8 Review the information to ensure that you have enough disk space. Click Install. 

The Install window appears and displays a progress meter. 

9 Insert the remaining CDs when prompted and browse to the \stage folder to continue the installation.

10 Click Exit when the installation is complete.

The Add Databases to tree dialog appears.

11 Click Cancel.

12 Choose File > Exit from the Oracle Enterprise Manager Console window.

Editing the sqlnet.ora File

For databases installed on Windows Server computers, you must check the sqlnet.ora file to make sure 
authentication services are configured correctly.

To edit the sqlnet.ora file:

1 Go to the d:\oracle\ora92\network\admin folder.

2 In a text editor, open the sqlnet.ora file and look for the following parameter:

SQLNET.AUTHENTICATION_SERVICES

3 If the parameter is set to (None), you do not need to edit the file.

4 If the parameter is set to (NTS), place a pound symbol (#) at the beginning of the line so it appears as follows:

# SQLNET.AUTHENTICATION_SERVICES= (NTS) 

Note If you do not want to comment out the line, you can change (NTS) to (NONE). 

5 Save and close the file.

This completes the Oracle installation.
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APPENDIX C
Installing Oracle 10g

This appendix provides instructions for installing Oracle 10g (10.2.0.1.0). It contains the following sections:
❑ Before Installing Oracle 10g on Windows
❑ Installing Oracle 10g Release 2 on Windows
❑ Installing Oracle Patch 4547817

Before Installing Oracle 10g on Windows
Before installing Oracle, you must:

❑ Check to see that the Microsoft NTFS file system is used instead of FAT or FAT32, and convert the file system if 
necessary. See “Checking the Windows File System” on page C-2 for directions.

❑ Determine the name of the Windows computer where Oracle is to be installed.      

Note It is required that the computer on which you are installing the Oracle database have at least two physical 
disks or two logical partitions. This allows you to place the operating system on the C drive and use the D 
drive for Oracle components. The examples in this chapter use a C and D drive.

❑ Be sure that you have Administrator privileges within Windows on the computers where you are installing Oracle 
and Agile PLM Datamart.

❑ Disable disk compression, if you are using it.

❑ Disable virus protection, if you are using it. Components used in the installer can be falsely identified as being 
infected and lock up the installation. You can turn the virus protection on after the installation is complete. 

Network Check

Before proceeding, it is important to confirm two settings to prevent difficulties from occurring.       

Confirming Computer Name and Hostname Identities

The computer where Oracle is installed must use the same value as both its computer name and its DNS hostname. 
The following procedures can be used to identify the current values.

To determine the computer name for Windows:   

1 Right-click the My Computer icon on the desktop, and choose Properties in the shortcut menu. 

2 In the System Properties dialog box, click the Computer Name tab. 

3 Note the name listed in the Full Computer Name field.
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Confirming the Server Date

It is important to adjust the date and time of the computer. The date and time need to be correct when you work 
with your production data.

To confirm the date and time, click the Date/Time icon in the Windows Control Panel. Be sure to verify the Time Zone 
setting, too.

Checking the Windows File System

Agile recommends that servers use NTFS (NT File System) rather than FAT or FAT32 (File Allocation Table), as 
NTFS is more robust. 

To determine the file system type:

1 Check the file system used on the computer. Choose Start >  Administrative Tools > Computer Management. Under 
Computer Management in the left pane, expand Storage and select Disk Management.

The Disk Administration windows opens.

There must be at least two partitions or hard drives. If your computer uses NTFS, proceed with the Oracle 
installation. If your computer uses a FAT or FAT32 file system, Agile recommends converting it to NTFS before 
proceeding.

Important Converting the file system deletes all current files on the drive. Backup all necessary files before 
converting the file system to NTFS. 

2 Right-click on the drive you want to reformat and choose Format in the shortcut menu.

3 In the File System field, change the file system type to NTFS.

4 Click Start.

The process takes several minutes. On completion, restart the system. You can proceed with the Oracle installation.

For Servers Configured with DHCP

If your server is configured with DHCP (Dynamic Host Configuration Protocol), there is a known issue with the 
Oracle 10g installation. The installation fails and the following message displays:

Thrown When the IP address of a host can not be determined

There are two possible solutions:

1 Copy the Oracle 10g installation software to your local disk and perform an off-network installation OR

2 Install the Microsoft Loopback adapter on the DHCP server, then add one entry to the hosts file. 

To install the Microsoft Loopback adapter:

1 Click Start > Control Panel > Add/Remove Hardware.

The Add/Remove Hardware wizard appears.

2 Click Next.

3 Choose Yes, I have already connected the hardware, then click Next.

4 Choose Add a new hardware device, then click Next.

5 Choose Install the hardware that I manually select from a list, then click Next.

6 Select Network adapters, then click Next.

7 In the Manufacturers list, select Microsoft.

8 In the Network Adapter list, select Microsoft Loopback Adapter, then click Next.
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9 Click Next to install the adapter.

10 Click Finish.

To configure the hosts file:

1 Open the hosts file, located at C:\Windows\System32\drivers\etc.

2 Add the following entry to the hosts file:

10.10.10.10 hostname.domain hostname

For example, if the full machine name of your database server is db1.agile.agilesoft.com, the entry in the hosts 
file would be:

10.10.10.10 db1.agile.agilesoft.com db1

3 Save the file.

To configure the loopback IP address on the network:

1 On the database server, right-click the My Network Places icon.

2 Choose Properties to display the Network and Dial-up Connections window.

3 Locate a connection with the device name of Microsoft Loopback Adapter. This connection is usually Local Area 
Connection 2.

4 Right-click this connection icon. 

5 Choose Properties to display the Local Area Connection 2 Properties dialog box.

6 On the General tab, select Internet Protocol (TCP/IP), then click Properties to display the Internet Protocol (TCP/IP) 
properties dialog box.

7 On the General tab, choose Use the following IP Address.

8 Enter the following values:

IP address: 10.10.10.10

Subnet mask: 255.255.255.0

9 Click OK. 

10 Click Close.

On completion, restart the system. You can proceed with the Oracle installation.

Installing Oracle 10g Release 2 on Windows
These instructions describe how to install and configure Oracle 10g to run with Agile PLM Datamart.

Note Throughout the instructions, default values are shown (such as the installation path or the service name). 
If you change any of these values during the installation, update the information specific to your 
installation where appropriate.

Important Make sure the Distributed Transaction Coordinator service is stopped.

To install Oracle 10g:         

1 Insert the Oracle database installation CD. You may have to navigate to the CD drive. 

2 Double-click the Setup icon. 

The Oracle Universal Installer command window and welcome screen appear. 

3 Click Next.

The Installation Method window appears.
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4 Select Basic Installation. Make sure the Oracle Home Location is on the D drive at d:\oracle\product\10.2.0\db_1 
which is the default if you have two disks.

5 Select Standard Edition as the Installation Type. Click Next.

Note Do not check Create Starter Database. You will create the Agile database with the Database Configuration 
Utility. 

The Product Specific Prerequisite Checks window appears.    

6 The Oracle Universal Installer verifies that your server meets the minimum requirements for installing and 
configuring the options you have selected. If your system passes, a summary window appears. Click Next.

7 Click Install.

8 Click Exit when the installation is complete.

This completes the Oracle installation.

Installing Oracle Patch 4547817
After you create the database instance for the Agile PLM Datamart (see “Installing the Agile PLM Datamart 
Database” on page 3-3), try starting the OracleServiceAADM service. If the service starts but the database remains 
idle, you should install Oracle patch 4547817.

To install Oracle patch 4547817:

1 Download Oracle patch 4547817 from Oracle Metalink (https://metalink.oracle.com/).

2 Stop all Oracle services on the database server.

3 Run setup.exe from Disk1 folder for the patch.  This program upgrades Oracle to 10.2.0.2.

4 Start the Oracle database service (OracleServiceAADM).

5 Open a Command Prompt window.

6 Start SQL*Plus and log in as the SYS user:

sqlplus sys/oracle as sysdba

It should say connected to an idle instance.

7 Start the database in upgrade mode:

SQL> startup upgrade;

8 Run the catupgrd.sql script, which is located in $ORACLE_HOME/rdbms/admin

SQL> @d:\oracle\product\10.2.0\db_1\RDBMS\ADMIN\catupgrd.sql

9 Run the Registry Editor (regedit). Make sure the ORA_<SID>_AUTOSTART value in the registry key 
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_OraDb10g_home1 is set to TRUE.

10 Restart the server.

Oracle should now start the database when the service is started.

https://metalink.oracle.com/
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APPENDIX D
Installing Embarcadero DT/Studio

This appendix provides a quick summary of how to install Embarcadero Technologies DT/Studio 2.3.1. It 
contains the following sections:
❑ About DT/Studio 2.3.1
❑ Downloading DT/Studio 2.3.1 Software
❑ Installing DT/Engine 2.3.1
❑ Installing DT/Console 2.3.1
❑ Applying the Cumulative Patch for DT/Engine 2.3.1, Build 2655
❑ Upgrading consolecomm.jar for DT/Console 2.3.1
❑ Upgrading the DT/Engine 2.3.1 JVM
❑ Managing DT/Engine 2.3.1 JVM Heap Size

About DT/Studio 2.3.1
This appendix provides a summary of installation steps for DT/Studio 2.3.1, a suite of Java-based ETL tools from 
Embarcadero Technologies. For complete installation instructions as well as hardware and software requirements, 
please see the separate DT/Studio documentation from Embarcadero Technologies.

DT/Studio includes the following components:

❑ DT/Engine – A data integration engine that can move and transform data between heterogeneous databases and 
files. DT/Engine’s ETL tool extracts the data from the source Agile PLM system, performs transformation needed 
on the source data, and loads the data into the Agile PLM Datamart.

❑ DT/Console – The monitoring component of DT/Studio. DT/Console is an administrative interface that lets you 
monitor the DT/Engine and remotely manage and schedule ETL tasks.

Agile requires that you install Embarcadero Systems DT/Studio on a Windows 2003 computer. DT/Engine can point 
to a metadata repository (such as an Oracle database) on a Windows computer. You can install DT/Engine and 
DT/Console in any order.

If a previous version of either DT/Engine or DT/Console is installed already, uninstall it before installing 
version 2.3.1.

DT/Engine Repository

DT/Engine stores data in normalized form in a metadata repository. The repository provides security, version 
control, and rollback capability. It also allows you to generate reports.
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Agile recommends using the same database server you are using for the Agile PLM Datamart for the DT/Engine 
repository database. Either create a new database instance on the Agile PLM Datamart computer, or add a new user 
to the Agile PLM Datamart instance called DTUSER (or something similar). When you install DT/Engine, you are 
prompted to specify the repository database. If you prefer, you can install DT/Engine without specifying a repository. 
However, you will need to specify and configure the repository later using DT/Console.

Note Before you install Agile PLM Datamart ETL components, you must set the DT/Repository. Otherwise, 
Agile PLM Datamart ETL tasks will not be uploaded to the repository.

Downloading DT/Studio 2.3.1 Software
You can download DT/Studio software, documentation, and patches from Agile’s public FTP server. For more 
information, contact Agile Software Operations.

Installing DT/Engine 2.3.1
To intall DT/Engine:

1 Start the dtengine-2_3_1-windows-setup.exe program.

2 On the Welcome screen, click Next.

3 Select “I accept the terms of the license agreement,” and then click Next.

4 Specify the directory in which to install the product (for example, D:\Program 
Files\Embarcadero\DTStudio\DTEngine2.3.1). Click Next.

5 Review the installation settings, and then click Next.

6 Choose whether to install shortcuts for DT/Engine on the desktop or the Start menu. Click Next.

7 On the Repository Database screen, select “Yes” to configure the repository database. Click Next

8 Select the database type (for example, OracleServer9i) and specify the database connection details. Make sure the 
database user you specify exists.

9 If a DT/Engine database repository already exists on that database, you are prompted to set or recreate the 
repository. Choose Recreate.

10 After you are prompted that the repository was successfully configured, click OK.

11 Specify the password for the dtadmin user. The default password is “dtadmin123”. Click Next.

Note For information about changing the DT/Engine password, see Appendix F, “Changing Passwords.”

12 Set the JVM minimum and maximum heap values, then click Next. The Configure Properties screen appears.

13 Accept the default configuration properties, and click Next.

14 Click Finish to complete the installation.

Installing DT/Console 2.3.1
To install DT/Console:

1 Start the dtconsole-2_3_1-win32-setup.exe program.

2 On the Welcome screen, click Next.

3 Select “I accept the terms of the license agreement,” and then click Next.

4 Specify the directory in which to install the product (for example, d:\Program 
Files\Embarcadero\DTStudio\DTConsole2.3.1). Click Next.
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5 Choose whether to install shortcuts for DT/Console on the desktop or the Start menu. Click Next.

6 Click Finish to complete the installation.

Applying the Cumulative Patch for DT/Engine 2.3.1, Build 2655
To apply the DT/Engine patch for build 2655:

1 Obtain the DT/Engine patch for build 2655 from Embarcadero Technologies.

2 Stop the DT/Engine and DTEngineManagerService.

3 Make sure the DT_HOME environment variable is pointing to the directory where DT/Engine is installed (for 
example, D:\Program Files\Embarcadero\DTStudio\DTEngine2.3.1).

4 Back up the dtpatchtool.jar file located in %DT_HOME%\lib. Copy the dtpatchtool.jar provided as part of this 
patch to %DT_HOME%\lib.

5 Open a command prompt and change to the %DT_HOME%/bin directory.

6 Run dtpatchtool.bat from the command prompt. This starts a patch tool shell.

7 Enter info to obtain information about the current DT/Engine version.

DTPatchTool> info

8 If your current version is earlier than build 2655, apply the patch. Use this syntax:

DTPatchTool> apply <patch_file_path>

For example, if the patch is located in d:\patch, enter the following command:

DTPatchTool> apply d:\patch\2655_r5.jar

9 Restart the DTEngineManagerService and the DT/Engine.

Upgrading consolecomm.jar for DT/Console 2.3.1
After you apply the patch to DT/Engine for build 2655, you must copy the consolecomm.jar file from DT/Engine to 
DT/Console.

To upgrade consolecomm.jar for DT/Console:

1 Stop DT/Console.

2 Rename %DT_CONSOLE_INSTALL_DIR%\lib\consolecomm.jar to 
%DT_CONSOLE_INSTALL_DIR%\lib\consolecomm.jar.bk.

3 After installing the DT/Engine patch for build 2655, copy %DT_HOME%\lib\consolecomm.jar to 
%DT_CONSOLE_INSTALL_DIR%\lib.

4 Restart DT/Console.

Upgrading the DT/Engine 2.3.1 JVM
After you apply the patch to DT/Engine for build 2655, you must also upgrade the DT/Engine JVM.

To upgrade the DT/Engine JVM:

1 Stop the DT/Engine and DTEngineManagerService.

2 Rename the existing %DT_HOME%\jdk1.4 folder to %DT_HOME%\jdk1.4_old.

3 Create a new folder named %DT_HOME%\jdk1.4.
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4 Copy the self-extracting JDK installer (dtengine-2_3_1-win32-installer.exe) to the %DT_HOME%\jdk1.4 
folder.

5 Run dtengine-2_3_1-win32-installer.exe. This self-extracting JDK installer extracts the new JDK files into 
%DT_HOME%\jdk1.4 folder.

6 Restart the DTEngineManagerService and the DT/Engine.

Managing DT/Engine 2.3.1 JVM Heap Size
After you install DT/Engine, you can modify the JVM heap values to tune performance.

To modify DT/Engine JVM heap values:

1 Stop the DT/Engine and DTEngineManagerService.

2 Change to DT/Engine bin folder, %DT_HOME%/bin.

3 Open dtengine.ja in a text editor.

4 Set the INIT_JAVA_HEAP, MAX_JAVA_HEAP and INIT_JAVA_STACK to optimal values. See “About JVM 
Heap Size” below.

For example:

%IF_EXISTS%("INIT_JAVA_HEAP", "@INIT_JAVA_HEAP@800m")
%IF_EXISTS%("MAX_JAVA_HEAP", "@MAX_JAVA_HEAP@800m")
%IF_EXISTS%("INIT_JAVA_STACK", "@INIT_JAVA_STACK@256k")

5 Restart the DTEngineManagerService and the DT/Engine.

About JVM Heap Size

The JVM heap is a repository for live objects, dead objects, and free memory. When a JVM runs out of memory in 
the heap, all execution in the JVM stops. A garbage collection algorithm then goes through memory and frees space 
that is no longer required by the application.

JVM Heap Size determines when the VM starts collecting DT/Engine garbage (deallocating unused Java objects). 
The smaller the heap, the more often garbage is collected. To minimize the time spent on garbage collection and 
maximize server efficiency:

❑ Make sure that the heap size is not larger than the available free RAM on your system. Typically, you should use 
80% of the free RAM available for your JVM.

❑ Lower the heap size if you find that your system is spending too much time collecting garbage.

❑ Set the Minimum Heap Size equal to the Maximum Heap Size. Setting the minimum heap size equal to the 
maximum heap size yields a higher performance throughput than setting the values differently. Setting equal 
values also prevents the JVM from spending time incrementing the heap.
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APPENDIX E
Troubleshooting

This appendix provides some troubleshooting tips about installing and maintaining the Agile PLM Datamart. 
It contains the following sections:
❑ Datamart Installation
❑ Plugin Installation in Clustered Environments
❑ ETL Tasks Installation
❑ Resizing the TEMP Tablespace
❑ Configuring the Autopurger Task
❑ Generating a Thread Dump of a DT/Engine Session
❑ Periodically Restarting the DT/Engine Service

Datamart Installation
This section provides troubleshooting tips for Agile PLM Datamart database installation.

Setting the OracleServiceAADM Service to Start Automatically

When you restart the database server, make sure the Agile PLM Datamart database instance started. If it did not start, 
it may be because the OracleServiceAADM service is not configured to start automatically when the machine is 
restarted. To fix this problem, open the Windows Services window, right-click the OracleServiceAADM service, and 
choose Properties from the shortcut menu. On the General tab, select Automatic for the Startup Type field.

Listener Configuration

If the Oracle database listener is not properly configured, ETL tasks will not be able to connect to the datamart. For 
instructions on configuring the listener, see “Adding and Configuring the Database Listener” on page 3-4.

Creating a Product Profile Table

After you create the datamart database and look at the installation logs, you may see the following warning:

Error accessing PRODUCT_USER_PROFILE
Warning:  Product user profile information not loaded!
You may need to run PUPBLD.SQL as SYSTEM

If a Product Profile table doesn’t exist on your database server, you can create one manually.
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To create a Product Profile table:

1 Open a Command Prompt window.

2 Go to the <oracle_home>\sqlplus\admin directory.

3 Start SQL*Plus and log in as system/manager:

D:\> sqlplus system/manager

4 Type @pupbld.sql and press Enter.

The Product Profile table is created.

Plugin Installation in Clustered Environments
This section provides information about installing the Agile PLM–Analytics Plugin in clustered environments. 

In general, the Analytics Plugin should be installed on all Agile Application Servers in the cluster. After installing the 
Plugin, Agile PLM should be restarted on all servers in the cluster.

Plugin Installation in Clustered Environment with BEA Weblogic Server

For clustered environment with BEA Weblogic Server, the Agile PLM–Analytics Plugin must be installed on the 
administrative server and all managed servers. 

Plugin Installation in Clustered Environment with Oracle Application Server

For clustered environment with Oracle Application Server, the Agile PLM–Analytics Plugin must be installed on the 
repository host server where Agile PLM is installed. It is not required to install the Plugin on non-repository host 
servers in the cluster. 

Error from Non-repository Host Server 

When installing the Plugin on OAS – specifically, on the repository host server – you may see an error from non-
repository host server(s). This would occur after re-deployment of Agile PLM by the Plugin Installer. To resolve this 
error, restart all non-repository host servers.

ETL Tasks Installation
This section provides troubleshooting tips for Agile PLM Datamart ETL tasks installation.

ETL Environment Variables and Classpath Settings

There are a few settings required for the Java code to be called successfully from the ETL task. For example, if the 
Java classpath is not set correctly, you’ll get errors when you try to run the ETL tasks.

AA_HOME Environment Variable

There should exist an Windows Environment variable by the name AA_HOME and this variable should have the 
path to the folder where Agile PLM Datamart ETL tasks are installed (for example, D:\Agile\Agile921\Analytics).

Classpaths

Make sure the classes folder for Agile PLM Datamart ETL tasks (for example, D:\Agile\Agile921\Analytics\classes) is 
included in the classpath. All JAR files contained in <AA_HOME>\lib folder should also be included in the classpath.
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Creating and Maintaining the Repository

The following error may be displayed in the DT/Engine logs or DT/Engine console window.

The database and the filesystem repositories are not in sync.

Note Some of the tasks may abort or produce incorrect results when executed.

To resolve this error, drop the current DT/Engine repository and recreate it.

To recreate the DT Repository from DT Console:

1 In the DT/Console Explorer, right-click the DT/Engine and select DT/Engine Properties from the shortcut menu.

2 Click Drop, and then click OK to confirm the drop. Click OK again when the repository is successfully dropped.

3 Click Create, and then click OK. 

4 Click Set. 

5 If prompted, log in again. (If you checked Connect Automatically when you logged in, you will not see this prompt.) 

6 Click OK to dismiss the message that the repository exists and is current.

Place the below list of files in the DT/Engine storage folder (for example, D:\Program 
Files\Embarcadero\DTStudio\DTEngine2.3.1\storage).

<AA_Home>\ETL\ADVPA\templatexmls\PLM_ADW_ADVPA_ALL.xml
<AA_Home>\ETL\Common\templatexmls\PLM_ADW_COM_ALL.xml
<AA_Home>\ETL\Common\templatexmls\PLM_AA_POST_TASK.xml
<AA_Home>\ETL\PA\templatexmls\PLM_ADW_PA_ALL.xml
<AA_Home>\ETL\PCA\templatexmls\PLM_ADW_PCA_ALL.xml
<AA_Home>\ETL\QA\templatexmls\PLM_ADW_PQA_ALL.xml
<AA_Home>\ETL\Staging\Common\templatexmls\PLM_AST_COM_ALL.xml
<AA_Home>\ETL\Staging\PA\templatexmls\PLM_AST_PA_ALL.xml
<AA_Home>\ETL\Staging\PCA\templatexmls\PLM_AST_PCA_ALL.xml
<AA_Home>\ETL\Staging\PQA\templatexmls\PLM_AST_PQA_ALL.xml

Run the InstallAgileTasks.bat file found at <AA_HOME>\ETL

Deploying the Agile PLM Datamart Task Chain

The Agile PLM Datamart ETL task chain is sometimes not deployed properly to the repository if the repository is 
not set prior to the Agile PLM Datamart installer being run or the DT/Engine service is not started during 
installation.

To deploy the Agile PLM Datamart task chain to the DT/Engine repository:

Run the InstallAgileTasks.bat found at <AA_HOME>\ETL.

Resizing the TEMP Tablespace 
If you run a DT/Studio task ‘AST_TRNSLT_AST_COM_MAP’ and the task aborts, you may see the following error 
in the task log file:

ORA-01652: unable to extend temp segment by 256 in tablespace TEMP

This error occurs because the TEMP tablespace initial size is too small and is not automatically extended. You can 
correct this problem by turning Autoextend on and setting the maximum size for the TEMP tablespace to be 
unlimited. However, since the TEMP tablespace is the default temporary tablespace for the database, you can’t alter 
it. You can get around that limitation by creating another TEMP2 tablespace and making it the default temporary 
tablespace while you drop and then recreate the TEMP tablespace.
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To resize the TEMP tablespace:

1 On the Agile9 database computer, open a Command Prompt window.

2 Run the following command:

D:\> SET ORACLE_SID=Agile9

3 Start SQL*Plus without connecting to the database:

D:\> sqlplus /nolog

4 Connect as the SYS user.

SQL> connect sys/<SYS_PWD> as sysdba

5 Create another temporary tablespace (TEMP2).

SQL> CREATE TEMPORARY TABLESPACE temp2 TEMPFILE 
  2  'D:\ORACLE\ORADATA\AGILE9\TEMP02AGILE9.ORA' SIZE 8M REUSE 
  3  AUTOEXTEND ON NEXT 8M MAXSIZE unlimited 
  4  EXTENT MANAGEMENT LOCAL UNIFORM SIZE 1M;

6 Make TEMP2 the default temporary tablespace.

SQL> ALTER DATABASE DEFAULT TEMPORARY TABLESPACE temp2;

7 Drop the original TEMP tablespace.

SQL> DROP TABLESPACE temp INCLUDING CONTENTS AND DATAFILES;

8 Recreate the TEMP tablespace with the correct size.

SQL> CREATE TEMPORARY TABLESPACE temp TEMPFILE 
  2  'D:\oracle\oradata\AGILE9\TEMP01AGILE9.ORA' SIZE 512M REUSE 
  3  AUTOEXTEND ON NEXT 8M MAXSIZE unlimited 
  4  EXTENT MANAGEMENT LOCAL UNIFORM SIZE 1M;

9 Make the new TEMP tablespace your default temporary tablespace.

SQL> ALTER DATABASE DEFAULT TEMPORARY TABLESPACE temp;

10 Drop the TEMP2 tablespace.

SQL> DROP TABLESPACE temp2 INCLUDING CONTENTS AND DATAFILES;

Configuring the Autopurger Task
Autopurger is a built-in DT/Studio Task that purges the execution logs of the tasks. By default, the autopurger task 
deletes logs older than ten days but retains logs for the ten most recent runs regardless of how old they are.

To change the default setting, edit the OLDER_THAN_DAYS and LEAVING_LAST_N_EXECUTIONS properties 
in the Autopurger.properties file located under <DT_HOME>\config directory.

Generating a Thread Dump of a DT/Engine Session
If the DT/Engine fails to run an ETL task, you can generate a thread dump. A thread dump is a textual dump of all 
active threads and monitors running in the Java Virtual Machine. It gives the exact line of code where the ETL task 
is hanging, allowing Agile Support to diagnose the problem.

To create a thread dump of a DT/Engine session:

1 Start DT/Engine from the Command Prompt:

a Navigate to the <DT_HOME>/bin folder from windows explorer.

b Edit the dt_engine.bat file to remove the -Xrs option from the batch file, i.e., edit the below line

set _jvm_args=-Xrs
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to 

set _jvm_args=

c Make sure DTEngineManagerService is NOT running.

d Open a Command Prompt window and go to <DT_HOME>\bin.

e Start the engine using the following command:

dt_engine start

2 Start DT/Console.

3 Run the ETL task that you had problems running earlier.

4 If the task hangs for a long time (for example, it exceeds the duration of the last successful execution run by two 
hours), take a thread dump by pressing CTRL-BREAK in the DT/Engine Command Prompt window. 

5 In the Command Prompt window, scroll back until you reach the line containing “Full thread dump.”

6 Right-click the title bar, and choose Edit > Mark. Highlight the entire text of the thread dump.

7 Right-click the title bar, and choose Edit > Copy.

8 Paste the thread dump into a text file and save it.

9 Send the thread dump file to Agile Support for analysis.

Note If you start DT/Engine using the DT Engine Manager user interface instead of a Command Prompt, you 
cannot generate a thread dump when an ETL task fails. 

Periodically Restarting the DT/Engine Service
To ensure adequate performance of DT/Engine, periodically restart the DT/Engine Manager service at least every ten 
(10) runs of the ETL tasks or every seven days, whichever occurs first.
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APPENDIX F
Changing Passwords

This appendix provides information about changing passwords. It contains the following sections:
❑ Changing the Datamart Password
❑ Changing the DT/Engine Password

Changing the Datamart Password
This task describes how to change the Datamart user password using the Datamart Password Change Utility.

To change the PLM Datamart password:

1 From the command prompt, run Datamart_Password.bat found in AA_HOME\ETL folder.

2 At the prompt, enter a new password for the AAD, AST, and ADW users.

If no password is entered three consecutive times, the Datamart Password Change Utility will exit without 
effecting any change to existing passwords.

Changing the DT/Engine Password
This task describes how to change the DT/Engine user password using the DT/Engine Password Change Utility.

To change the DT/Engine password:

1 Log in to DT/Engine with default username and password of dtadmin and dtadmin123, respectively.

2 Right-click on the user row and select Change Password... from the menu.

3 In the Change Password dialog:

• Type in the old password (“dtadmin123”)

• Type in the new password (let’s say, “dtadmin321”)

• Confirm by retyping the new password. 
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When you are finished, click OK.

4 Execute DTEngine_Password.bat with the new password. 

First, change the directory to your Analytics “home”\ETL directory, for example:

cd D:\Agile921\Analytics\ETL

5 At the prompt, type DTEngine_Password.bat and the new password. So, using our example password:

D:\Agile921\Analytics\ETL>DTEngine_Password.bat dtadmin321

If no password is entered three consecutive times, the DT/Engine Password Change Utility will exit without 
effecting any change to existing passwords.

6 Restart DT/Engine Manager Service.

7 Start DT/Engine 2.3.1.

8 Start DT/Console and log in to DT//Engine with username (“dtadmin”) and the new password (in our example,  
“dtadmin321”).

9 You can now initiate a PLM Analytics task chain.
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